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Audience
Whether you’re an experienced system administrator or you just want to dig deeper into 
macOS, you’ll learn to update, upgrade, reinstall, configure, maintain, diagnose, and trou-
bleshoot macOS Monterey.

You should be comfortable using a Mac before you read this guide. If you’re not sure 
about basic Mac use, refer to “Are you new to Mac?” at support.apple.com/guide/
macbook-pro/are-you-new-to-mac-apd1f14ec646.

How to Use the Guide
Use the reference sections to get familiar with macOS Monterey. Then, use the exercises to 
practice what you’ve learned. After you’ve completed the guide, you should be able to:

 ▶ Explain how macOS Monterey works
 ▶ Explain the best practices for updating, upgrading, reinstalling, configuring, and 

using macOS Monterey
 ▶ Explain macOS Monterey troubleshooting and repair procedures
 ▶ Use appropriate tools and techniques in macOS Monterey to diagnose and resolve issues

Accessing the Web Edition and Lesson Files
Unless otherwise specified, references to macOS in this guide refer to macOS Monterey 12.1. 
When you buy this guide from Peachpit (in any format), you automatically get access to 
its Web Edition and the accompanying lesson files.

If you bought an ebook from peachpit.com, your Web Edition will appear under the 
Digital Purchases tab on your Account page. If you bought an ebook from a different 
vendor or you bought a print book, you must register your purchase on peachpit.com 
to access the online content:

1 Go to peachpit.com/macosMonterey.

About This Guide

http://support.apple.com/guide/macbook-pro/are-you-new-to-mac-apd1f14ec646
http://support.apple.com/guide/macbook-pro/are-you-new-to-mac-apd1f14ec646
http://peachpit.com
http://peachpit.com
http://peachpit.com/macosMonterey
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2 Sign in or create a new account. 

The Register a Product page opens, with the book’s ISBN already entered in the text field.

3 Click Submit.

4 Answer the challenge question as proof of purchase.

5 You can access the lesson files from the Registered Products tab on your Account 
page. Click the Access Bonus Content link below the title of your product to proceed 
to the download page. 

6 Click the lesson file link(s) to download them to your computer, and when you are 
asked to allow downloads on www.peachpit.com, click Allow.

The student materials for these exercises will be downloaded as a ZIP archive and 
automatically expanded into the StudentMaterials folder.

7 You can access the Web Edition from the Digital Purchases tab on your Account page. 
Click the Launch link to access the product.

Exercises
The exercises in this guide are designed for independent learners and require a dedicated 
Mac. If you use a Mac that is also used for daily productivity, the exercises will not work 
as expected and they might disrupt your Mac. To complete the exercises, ensure that you 
have the following:

 ▶ A Mac with Apple silicon or an Intel-based Mac that meets the requirements to install 
macOS Monterey

 ▶ macOS Monterey (see Exercise 2.3, “Erase a Mac and Install macOS Monterey”)
 ▶ A high-speed internet connection
 ▶ Lesson files (see “Accessing the Web Edition and Lesson Files,” earlier)
 ▶ An Apple ID dedicated to your independent learning (you don’t need to provide 

credit card information to get free apps from the App Store)

The following items are not required, but they can be helpful:

 ▶ An iCloud account associated with the Apple ID you use for your independent learning
 ▶ An erasable external storage disk with a capacity of at least 14 GB for Exercise 5.2, 

“Create a macOS Install Disk”
 ▶ At least two Wi-Fi networks (one should be visible)
 ▶ A Mac with a solid state drive

http://www.peachpit.com


Additional Materials

Apple Support
The Apple Support website (support.apple.com) includes the latest free online 
Apple Support articles.

Additional Materials  xvii

http://support.apple.com
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When you log in to your Mac, you can securely store docu-
ments in your home folder. You can also store and access 
documents in other locations, but this lesson focuses on your 
home folder. In macOS Catalina or later, your home folder 
is stored on the read-write APFS Data volume, technically 
separate from your read-only APFS System volume, but this 
separation doesn’t make a difference in troubleshooting.

NOTE ▶ Illustrations in this chapter show conditions 
when different users are logged in. Local Administrator 
is logged in in most illustrations, but the sidebar will 
show that John Appleseed is logged in with an Apple ID 
and is using iCloud Drive as well as backing up using 
Time Machine.

Reference 8.1  
User Home Folders
The default location for a locally stored home folder is  
/Users/name, where name is the user account name.

Many Mac users don’t have much reason to think about 
files and folders outside of their home folder. But if you’re 
going to share files with other users on your Mac, share 
files to other devices on your network, or help someone else 
troubleshoot their Mac, it helps to understand how the Users 
folder fits into the file system in general.

Lesson 8

Manage User 
Home Folders

GOALS

 ▶ Describe user home 
folders

 ▶ Delete users’ accounts 
and preserve their 
home folder contents

 ▶ Migrate and restore 
home folders
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One way to start is with the Finder. Choose Go > Computer (or press Shift-Command-C). 
The Finder displays your startup disk, which is named Macintosh HD by default.

NOTE ▶ The Finder might also display other storage devices if they are mounted. 
Additionally, macOS simplifies how it presents parts of the file system in Terminal 
and in the Finder; you’ll find more details in Lesson 11, “Manage File Systems and 
Storage.”

After you open your startup disk, the Finder displays folders, including the Users folder.
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The Users folder contains home folders and the Shared folder. Additionally, if the Guest 
user was ever turned on, you’ll also see the Guest folder. The Finder displays your home 
folder with an icon of a house. In the following example, jane, john, kcavanna, and ladmin 
are user account names.

In the Finder window toolbar, click the View As menu (it’s circled in the previous fig-
ure), then choose “as Columns” (or choose View > As Columns) to change how the Users 
folder is presented.

NOTE ▶ By default, the Finder window displays the View As menu, but if your 
Finder window is wide enough, it displays four View buttons (Icons, List, Columns, 
and Gallery) instead of the View As menu.
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As the following figure illustrates, the Users folder appears to be contained inside your 
startup disk and the Users folder contains home folders.

When you create a new user account, macOS generates a home folder for that account. 
The home folder contains these default visible home folders: Desktop, Documents, 
Downloads, Movies, Music, Pictures, and Public. In the Finder, you can open your home 
folder by choosing Go > Home or by pressing Shift-Command-H.
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NOTE ▶ If you are signed in with your iCloud account and you have iCloud Drive 
turned on, with the Desktop & Documents Folders option enabled, then the Finder 
displays your Desktop and Documents folders only in the Finder window sidebar, in 
the iCloud section. Reference 19.4, “Store Documents in iCloud,” covers this in detail.

Files you save to your desktop appear on your desktop and in the Desktop folder.
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You can use stacks on the desktop to keep files neatly organized in groups. When you 
save a file to the desktop, it’s automatically added to the appropriate stack. This helps you 
keep your desktop tidy. To turn on the Stacks feature, click the desktop to make the Finder 
the active app; then from the View menu, choose Use Stacks. Or at any point you can 
Control-click the desktop and choose Use Stacks.

       

When you download content from the internet, it goes into the Downloads folder by default.

Your home folder also contains a folder called Library that includes user-specific prefer-
ence files, fonts, contacts, keychains, mailboxes, favorites, screen savers, and other app 
resources. The Library folder is hidden in the default Finder view.

The Documents, Movies, Music, and Pictures folders are the default locations for docu-
ment, movie, music, and picture files, respectively.

If you open other users’ home folders, you can’t see inside their default folders, except for 
their Public folders.
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But if someone stores a file at the top level of their home folder—not inside a folder 
in their home folder—other users can see that file. You’ll find more information about 
changing the permissions for a file in Lesson 13, “Manage Permissions and Sharing.” The 
following figure illustrates that if John stores a file called Confidential Salaries in his home 
folder, another user on that Mac will be able to see and open that file (but not make any 
changes to it).
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If you want to share items with other users on your Mac, put these items in your Public 
folder. If you turn on the File Sharing service, users who connect to your Mac can see files 
here, too. Lesson 25, “Manage Host Sharing and Personal Firewall,” has more informa-
tion about sharing files over the network. The following figure is from the perspective of 
John Appleseed, for a file named Shared Task List in John Appleseed’s Public folder.

Other users can view the contents of your Public folder, and you can view the contents of 
any other user’s Public folder. Continuing the example from the previous figure, the fol-
lowing figure illustrates how the Finder displays the contents of John Appleseed’s home 
folder, including his Public folder, to other local users.

If you want to give a copy of a file to another user, you can use the other user’s Drop Box 
folder. The Drop Box folder (not to be confused with a third-party service with a similar 
name) is a special folder. Every user has a folder named Drop Box that’s inside that user’s 
Public folder. You can put files into another user’s Drop Box folder, but you can’t remove the 
files once you put them there. And you can’t see what’s inside another user’s Drop Box folder.
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Except for putting items in Drop Box, other users can’t add items or make changes to files 
in your Public folder.

You can change folder permissions as described in Lesson 13.

You might see an Applications folder in your home folder. When you are logged in as a 
standard user and install some apps, they automatically create an Applications folder in 
your home folder. For other apps, you can choose to place them there. Only you have 
access to the contents of your personal Applications folder (though someone with access 
to an administrator user account can take steps to access your personal Applications 
folder). See Reference 18.3, “Install Apps Using Drag-and-Drop and Software Packages,” 
for more information.

Reference 8.2  
Delete User Accounts and Preserve Their Home Folder Contents
You might have to delete a user account. If you do, you must decide what to do with the 
user’s home folder contents.

To delete a user:

1 Select the user from the list of users in Users & Groups preferences.

2 Click the Remove (–) button at the bottom of the list.
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3 Select an option for the user’s home folder contents:

▶ Select “Save the home folder in a disk image” to save a user’s home folder as a 
disk image file. macOS saves the disk image file in the /Users/Deleted Users folder 
and gives it the user account name. You can copy it to other Mac computers or into 
another user’s home folder. You must have enough local storage space to duplicate 
the home folder. The process might take several hours depending on how much stor-
age the home folder uses.

NOTE ▶ As this guide went to press, this option wasn’t available.

▶ Select “Don’t change the home folder” to leave a user home folder unchanged. 
macOS appends “(Deleted)” to the home folder name to signify that the user no longer 
exists. The deleted user home folder keeps the same access restrictions as a normal 
user home folder. If you want to access the deleted home folder contents, you must 
change folder and file ownership and permissions. Read Lesson 13 to find out more.

▶ Select “Delete the home folder” to delete home folder contents. The content won’t 
be stored in the Trash, so you can’t easily restore it.

Reference 8.3  
Migrate and Restore Home Folders
Migration Assistant enables you to copy settings, user accounts, and content from a Mac 
or Windows computer to your new Mac.
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You can copy content over Wi-Fi, Ethernet, or an appropriate cable. If you have a lot of 
content, the copy could take several hours. If one or both computers are notebook com-
puters, be sure to plug them into a power source before you start.

You can copy your content from a Time Machine backup too. If you don’t have a 
Time Machine backup of the original Mac content, create one. Connect the external 
storage device that contains the Time Machine backup to your new Mac.

When you migrate content from another Mac, a Time Machine backup, or a startup 
disk, Migration Assistant scans the local network for Mac computers that are running 
Migration Assistant and are ready to transfer content.

Migration Assistant scans locally mounted disks and the local network looking for 
Time Machine backups. It scans locally mounted disks for a previous system as well. 
Previous systems include external disks, or Intel-based Mac computers in target disk 
mode, that are connected with an appropriate cable or adapter. Using target disk mode 
is detailed in Lesson 11. Refer to Apple Support article HT204350, “Move your content 
to a new Mac,” for instructions.

When you migrate content from a Windows computer, Migration Assistant scans the local 
network for Windows computers that are running Windows Migration Assistant and are 
ready to transfer content. This enables you to migrate content from Windows 7 or later if 
the Windows computers are running Windows Migration Assistant. You can download 
Windows Migration Assistant from the Apple Support website. Refer to Apple Support 
article HT204087, “Move your data from a Windows PC to your Mac,” for detailed 
instructions.

Migration Assistant runs as part of macOS Setup Assistant on new or newly reinstalled 
Mac computers. You can use Migration Assistant at any time. It’s in /Applications/Utilities. 
You can search for it with Spotlight or Launchpad.

1 Before you use Migration Assistant, check for Apple software updates on the source 
and destination computers.

This ensures that you’re using the latest copy of Migration Assistant.

2 If any other users are also logged in, log out all other users.

3 Open Migration Assistant.

4 Click Continue to start Migration Assistant.
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5 Authenticate as an administrator user.

Migration Assistant quits running apps and logs out users.

6 Select how you want to transfer information:

▶ From a Mac, Time Machine backup, or Startup disk

▶ From a Windows PC

▶ To another Mac

If you select “From a Mac, Time Machine backup, or Startup disk” or “From a 
Windows PC,” Migration Assistant scans attached disks and the local network for 
migration sources. If you select “To another Mac,” open Migration Assistant on the 
destination Mac as well.

The rest of this list addresses the scenario where you select “From a Mac, 
Time Machine backup, or Startup disk.”

7 Select the source external storage device. When you select a Time Machine backup, 
you can select a backup from a specific date and time.
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8 After you select a source, Migration Assistant scans the contents and presents you 
with a list of items you can migrate.

Migration Assistant doesn’t create new volumes or partitions on the destination Mac. 
It creates folders that include the contents of the migrated source.

Select the information you want to transfer; this includes user accounts. Then click 
Continue.
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9 After you make selections, record the temporary, random password that 
Migration Assistant assigns to all standard users that you will migrate. If you don’t 
record the random password, you’ll have to reset each user’s password, which 
resets their login Keychain. This is covered in more detail in Reference 10.2, “Reset 
Lost Passwords.” When a user first logs in using the temporary password that you 
provide them, macOS prompts them to change their password. If they provide 
their old password, their login Keychain will not be modified.

10 Click Set Password for an administrator user account.

11 Enter and verify a password for the administrator account that you’re migrating, then 
click Set Password.

12 Repeat steps 10 and 11 for any additional administrator accounts.

13 If you want to promote a standard user to an administrator user, click “Promote to 
Admin” next to the user, and then set and verify a new password for that user.
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14 Click Continue.

15 If any user account that you selected to restore already exists on your Mac, 
Migration Assistant displays a prompt for each conflicting user account. You can 
replace the user account, optionally keeping its home folder, or keep both user 
accounts by entering a new name and user account name.

16 To add new users to your Mac, Migration Assistant must collect a password from an 
existing administrator user who is authorized to create new users. Next to an admin-
istrator user, click Authorize.

17 Enter the password for the user you selected, then click OK.

18 Click Continue to begin the transfer. The more content you transfer, the longer it takes.
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Manually Restore a User Home Folder
See Exercise 8.1, “Restore a Deleted User Account,” to learn how to restore a user’s home 
folder after you delete that user.

Exercise 8.1  
Restore a Deleted User Account

▶ Prerequisite

 ▶ You must have created the Local Administrator account (Exercise 3.1, 
“Configure a Mac for Exercises”).

In this exercise, you create a user account and create files in the user’s home folder. Then, 
you delete the account, preserving the contents of the home folder. You also create a new 
account, ensuring that the new user gets the old user’s home folder contents and chang-
ing the user account name. What you learn in this exercise provides an alternative to 
Migration Assistant for moving user accounts between Mac computers.

The scenario for this exercise is that Karina Rossi changed her name and now has the 
last name of Cavanna. The company she works for uses the account naming convention 
first initial, last name. So, you must change her account name from krossi to kcavanna.

Create Karina Rossi’s Home Folder

1 Log in as Local Administrator.

2 Open Users & Groups preferences.

3 Authenticate as Local Administrator.

4 Click the Add (+) button under the user list.

5 Enter the account information for Karina Rossi:

New Account: Standard

Full Name: Karina Rossi

Account Name: krossi
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Password: Apple321!

Verify: Apple321!

Don’t provide a password hint.

6 Click Create User.

You can optionally change the account picture.

7 Control-click Karina Rossi’s account, then choose Advanced Options from the menu.

Take a screenshot of the System Preferences window to record Karina Rossi’s account 
attributes for later reference.

8 Press Shift-Command-5, followed by the Space bar.

Your pointer changes to a camera icon, and the region of the screen it is over is high-
lighted in blue. If you see a crosshair, press the Space bar again.

9 Move the camera pointer over the System Preferences window, then click to record its 
contents.

This is one of several ways of taking screenshots in macOS. Shift-Command-3 records 
the entire screen, Shift-Command-4 enables you to select a rectangular region to 
record or a single window if you hold down the Space bar, and Shift-Command-5 gives 
you the ability to do timed captures, record the screen, and select destinations for your 
screenshots. Refer to support.apple.com/guide/mac-help/mh26782 in the macOS User 
Guide for more information on taking screenshots or screen recordings on a Mac.

The image is saved to your desktop and named “Screen Shot,” followed by the date 
and time it was taken.

10 In the Advanced Options dialog, click Cancel, or press Command-Period, which is a 
way to select Cancel in most macOS dialogs.

11 Log out as Local Administrator.

12 Log in as Karina Rossi (password: Apple321!).

13 In the Accessibility pane, turn on any assistive needs, then click Continue. If you don’t 
want to configure Accessibility at this time, click Not Now.

14 In the Data & Privacy pane, carefully review Apple’s privacy policy, then click Continue.

http://support.apple.com/guide/mac-help/mh26782


228   Manage User Home Folders

15 In the Sign In with Your Apple ID pane, click Set Up Later, then click Skip in the con-
firmation dialog.

If the Find My pane appears, click Continue.

16 In the Screen Time pane, select Set Up Later.

17 If the Siri pane appears, deselect Enable Ask Siri, then click Continue.

18 If you’re asked to set up Touch ID, select Set Up Touch ID Later, then click Continue 
in the confirmation dialog.

19 At the Choose Your Look pane, choose your preferred appearance, then click Continue.

20 In the Dock, click the Launchpad icon.

21 In Launchpad, begin typing text.

TextEdit should become available.

22 Click the TextEdit icon to open TextEdit.
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23 In the Untitled document, type the text This is Karina Rossi’s project document.

24 From the menu bar, choose File > Save (or press Command-S) to save the file.

25 Name the file Project, then save it to Karina Rossi’s desktop. You can use the shortcut 
Command-D to select the desktop.

26 Quit TextEdit.

27 Open System Preferences, then click Desktop & Screen Saver preferences.

28 Select a different desktop picture.

29 Quit System Preferences, then log out of the Karina Rossi account.
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Delete Karina Rossi’s Account
Next, you delete Karina Rossi’s account without removing the files in her home folder.

1 Log in as Local Administrator.

2 Open Users & Groups preferences, then unlock the pane.

3 Select Karina Rossi’s account name, then click the Remove (–) button to remove her 
account.

4 In the dialog that appears, select “Don’t change the home folder.”

5 Click Delete User.

Karina Rossi’s account is no longer visible in the list.

6 Quit System Preferences.

7 Navigate to /Users. Open Macintosh HD from your desktop and open the Users folder.

Karina Rossi’s home folder still exists, and (Deleted) is appended to the end of the name.
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Restore Karina Rossi’s Account for Karina Cavanna
Karina Rossi’s files (soon to be Karina Cavanna’s files) still exist in the Users folder. Now 
you rename the home folder so that when you create the new account, she gets the files 
and settings from her previous account (the Karina Rossi account).

1 If necessary, navigate to the folder /Users.

2 Control-click the krossi (Deleted) folder, choose Rename, and change the folder name 
to kcavanna.

3 Press Return.

The file permissions in the /Users folder don’t enable you to modify items within it. 
The Finder asks you to authenticate as an administrator to override the permissions.

4 Enter the Administrator password and click OK.
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5 Open the kcavanna folder, and then attempt to open the Desktop folder.

You are prohibited from viewing the contents because the owner of the folder is still 
the old krossi account.

6 Control-click the Desktop folder and choose Get Info. Click the Sharing & Permissions 
disclosure triangle if necessary to inspect the item permissions.

Notice that macOS attempts to find krossi (the process is shown as Fetching), who no 
longer exists. Also notice that no one but the old owner (who was krossi) has permis-
sions to view anything inside the Desktop folder.
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7 Click the lock and authenticate as Local Administrator.

8 Click Add (+).

9 Choose Local Administrator, and click Select.

Notice that you are granted Read Only permissions by default. You could change this 
to Read & Write, or become the owner of the folder, but for the purposes of this exer-
cise, Read Only is sufficient.

Also notice that the prohibitive badge is no longer displayed on the Desktop folder.

10 Open the Desktop folder.

You see Karina Rossi’s Project document. After you create Karina Cavanna’s account, 
she retains this document, along with all the other settings pertaining to her account.

Now you will remove Local Administrator’s permissions to see the Desktop folder.
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11 If necessary, right-click the Desktop folder and choose Get Info.

12 Authenticate as Local Administrator, and remove “ladmin (Me).”

It’s no longer necessary for the Local Administrator user to have permissions to view 
the Desktop folder and its contents. If you leave Local Administrator’s permissions to 
see Karina’s Desktop folder, the user will be able to see files that are not intended for 
the Local Administrator to view.

Create and Verify Karina Cavanna’s Account
Create the Karina Cavanna user account using the renamed home folder as her new 
account home folder.

1 Open Users & Groups preferences.

2 Authenticate as Local Administrator.

3 Click the Add (+) button to create another account:

New Account: Standard

Full Name: Karina Cavanna

Account Name: kcavanna

Password: Apple321!

Don’t provide a password hint.

4 Click Create User.

A dialog appears asking whether you want to use the kcavanna folder for this account.
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5 Click Use Existing Folder.

6 Control-click Karina Cavanna’s account, then choose Advanced Options from the menu.

7 Open the Screen Shot file on your desktop, then compare the account attributes of 
Karina Cavanna’s new account with her original account (Karina Rossi).

macOS assigns each account a new UUID (Universally Unique Identifier) when you 
create it.

8 Quit Preview.

9 In the Advanced Options dialog, click Cancel, then quit System Preferences.

10 Try to reopen the Desktop folder in Karina Cavanna’s home folder. If your Finder 
window is still displaying the Desktop folder, click the Back button, then double-click 
the Desktop folder. You no longer have permission to see the files because they are 
owned by Karina Cavanna’s new account.

11 Close the Finder window.

Verify Karina Cavanna’s Home Folder
Explore Karina Cavanna’s home folder to confirm the files are available.

1 Log out as Local Administrator, then log in as Karina Cavanna.

2 Verify that the Project file is on the desktop and that the desktop picture is the one 
you chose previously.
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3 In the Finder, open Karina Cavanna’s home folder by choosing Go > Home (or by 
pressing Shift-Command-H).

4 Make sure you can see the default subfolders: Desktop, Documents, Downloads, 
Movies, Music, Pictures, and Public.

5 Open the Desktop folder, then verify that you see the Project document.

6 Navigate back to the home folder, then open the Public folder, where you see a Drop 
Box folder. For more information about these folders, read Lesson 13.

In addition to the visible folders in Karina Cavanna’s home folder, the folder should 
contain an invisible Library folder.

7 Press and hold the Option key, then choose Go > Library.

The Library choice is hidden except when you hold the Option key.

Karina Cavanna’s Library folder contains many subfolders. For more information 
about this folder and its contents, read Reference 14.1, “Examine Hidden Items,” and 
Lesson 15, “Manage System Resources.”

8 Close the Library folder, then log out as Karina Cavanna.
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Activity Monitor, 629–633, 941–942
administrator account

app security and, 520
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Apple Advertising, 257
Apple Configurator 2, 126, 532, 533, 931
Apple Diagnostics, 122, 924–927
Apple Filing Protocol (AFP), 338, 768, 770, 773–774
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one-time opens, 593
peripherals and, 858–859
purchased, 519
registering, 550
removing, 544–546
Rosetta for, 614–616
sandboxed, 435–436, 520–521, 645
security of, 520–526
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automatic saves, 561, 570, 597–600
automatic updates, 156, 158, 163–164
automation, 257, 817

B
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See also Time Machine
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network host ID via, 756
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new, 337
repairing, 364–366
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Create a Computer Account, 50–51



946   Index

CUPS, 864, 888, 899
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recovery, 354–355
unrecoverable, 241

default apps, 594–597
deletions

account, 219–220, 230
local storage, 591
restoring account, 226–236
restoring files, 503–506

desktop
Dynamic Desktop, 60–61
iCloud storage of, 575–577, 581–583
management, 216
virtual access to, 806

device classes, 857
DHCP (Dynamic Host Configuration Protocol)

configuring, 719–721
function of, 670, 673
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external volume, 349–350
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TLS, 817
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environment, user, 912–913
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Erase Mac, 140, 936–940
erasures

disk, 347–349
Erase Assistant, 936–940
file, 349
Monterey, 37–41
remote, 267–270
startup disk, 14
storage device, 361–363
unsupported disk, 488–489
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File Sharing service, 798–799
file systems

APFS, 328–338
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metadata for, 449–450
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FileVault
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password resets with, 300–303
privacy settings, 253
recovery, 123, 371–372, 374, 377–382
turning on, 79–81, 370–374
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Find My, 51, 262–270, 938
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Finder
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mount/unmount/eject, 338–341
opening files in, 547–549
permissions and, 394–397
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preview pane, 552–555
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troubleshooting, 827
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startup and, 902, 905–907
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creating, 115–117
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adding, 441–443
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force quits, 635–636, 650–655
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FTP (File Transfer Protocol), 769, 775
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Full Security, 137
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Go to Folder, 412–413
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group permissions, 385
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H
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troubleshooting, 931
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hidden items
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hierarchical permissions, 388
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permissions, 390–392, 399–400
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host command, 749–750
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host-sharing services
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remote control and, 806–817
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kernels, 902, 908–909, 933
keyboard, wireless, 850
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L
LAN (local area network) traffic, 670, 698
Launch Services, 551–552
launchd process, 433, 902, 909–911, 934
LaunchDaemons, 433, 910
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less command, 103, 104
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contents of, 216
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apps for recovering, 143
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memory, 610
printing in, 863–865
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macOS Big Sur, 5, 14, 329, 521
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installing, 37–41, 148–154
reinstalling, 127
requirements for, 15–20
sleep mode, 915
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macOS Monterey 12
defined, 3
Help, 10–12
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macOS Recovery
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FileVault and, 369
how to use, 127–129, 141–148
password resets with, 303–304, 309–312
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memory, 610, 632, 633
Messages app

configuring, 765–766
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examining, 473–477
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disks, 338–341, 423
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network interface, 667, 691
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network protocols
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file service, 768
interfaces and, 694–698
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network services
apps, 757–767, 782–784
defined, 667, 691
dynamic service discovery, 754–756, 769
file system, 768–778
firewall for, 821–826
host sharing, 793–805
identification, 754, 756–757
list inspection, 699–700
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software, 753–754
troubleshooting, 732, 778–785, 826–828
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advanced configuration, 707–718
configuring, 674–683
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interfaces and protocols, 694–697
location management, 691–693, 719–725
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new setups and, 45–46
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VPN settings, 702–706
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activity of, 670–673
configuring, 674–683
connecting to Wi-Fi, 683–687
connectivity issues, 687–689, 745–750
identification of, 795–796
terminology, 667–669
troubleshooting, 731–750

New Blank Image, 423
new items, 393
NFS (Network File System), 768, 775
No Security, 138
notarization, 521, 543
Notes, configuring, 762
Notification Center, 156–157, 626–628

O
open-source software, 3
operating system history, 12
optimized storage, 580–581, 589–592
options, 97
ownership, permissions and, 384–386

P
packages

defined, 413
examining, 413–415
installing, 415, 527–529, 535–538

pairing, 850, 853–854
parents, 803
partitions, 326–327
Password Assistant, 298–299
passwords

Apple silicon resets, 377–379
backup, 482, 484–487
changing, 297–299, 320–322

firmware, 123, 134–136
Intel-based resets, 379–381
keychain storage for, 281–283
Recovery Assistant, 139
resetting lost, 299–305, 309–315
restoring original, 381–382
security for, 237–241
user keychains, 305–309
Wi-Fi, 676

Passwords System Preferences, 246–248
pathnames, 99, 110
PDF documents, 883–884, 898
Pearson Education, 81
peers, 803
peripherals

Bluetooth, 849, 850–856
technology types, 843–850
Thunderbolt, 847–849
troubleshooting, 857–859
USB, 844–847

permissions
default, 399–405
file system, 383–389
managing, 393–398
network, 768
remote control and, 807–812, 815
sharing and, 389–393
testing changes, 405–408

personal firewall
configuring, 835–840
managing, 821–826
security and, 253
troubleshooting, 827

Photos Editing extensions, 621
ping command

connectivity tests with, 739–741, 748–749
stealth mode, 838
Terminal, 780–782

plug-ins
framework, 858
Quick Look, 556–557
Spotlight, 463

Point-to-Point Protocol over  
Ethernet (PPPoE), 696
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POSIX-style permissions, 386
power nap, 916–919
power-on selftest (POST), 905
preferences

app, 644–649, 655–661
Bluetooth, 850–851
locked, 57–58
Network, 687–689, 692, 732
privacy, 119–120
Sharing, 793
Siri, 468–471
Spotlight, 471–473
System, 55–59, 73–81
system resources, 433
Time Machine, 490–491

Preferred Networks, 727–730
Preview pane, 623, 656
printers and scanners

AirPrint, 863
configuring, 865–879, 888–893
CUPS, 864
drivers, 864–865
managing, 880–886, 893–898
troubleshooting, 857, 886–888, 899–900

privacy
account, 253–261
analytics and, 52
Data and Privacy, 33
editing preferences, 119–120
keychains and, 241–250
lost devices, 262–271
managing user, 253–261
password, 237–241

Private Relay, 254
processes, 609–610, 629–633
Profiles pane, 67–70
protected memory, 610
protecting data, 240–241
protocols, network

defined, 667
file service, 768
interfaces and, 694–698
network location, 691

proxy servers, 716–717
Public folder, 216, 218–219
public networks, 802
pwd command, 110, 111

Q
quarantine, file, 522–523
queues, print, 884–886, 896–898
Quick Actions

extensions, 623
features, 558–559
shortcuts, 623–626

Quick Look
extensions, 622
features, 555–556
plug-ins, 556–557
viewing files with, 593
window, 557–558

Quick Note, 6–7
quits

force, 635–636, 650–655
resumes after, 570

R
Recommendations, 590
recovering data, 354–355
Recovery Assistant, 139–140, 939
recovery keys, FileVault

resetting logins with, 300–303
turning on, 79–80
use of, 374, 377–382

recoveryOS, 126, 127, 142
recursive characters, 105
reformatting storage devices, 150–152, 361–363
regional selection, 45
registering apps, 550
relative paths, 99, 110
Reminders, 762–764
remote computer control, 806–817, 830–832
Remote Management, 32, 806
removal, software, 529–530, 544–546
reports, diagnostic, 637–644, 661–664
resource passwords, 238
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Restart, 148
restart

apps, 634
FileVault-protected, 375–376
loginwindow and, 921

restores
backed-up files, 492–497
deleted account, 226–236
home folder, 226

Resume, automatic, 569–570
rm command, 106
rmdir command, 106
roles, volume, 329
root accounts, 91, 107, 180–181
root folders, 431–432
root volume, 102
Rosetta, 612, 614–616
router address, 669

S
Safari

keychain items in, 243–248
network configuration, 757
privacy and, 259–261
rendering issues, 782–784
updates, 7

safe mode, 927–929, 935, 940–942
safe sleep, 915–916
sandboxed apps, 435–436, 520–521, 645
saves

automatic, 598–599
disabling automatic, 570
documents, 561–569
iCloud, 604
web information, 243–244

scanners.  
See printers and scanners

screen locks, 276
Screen Sharing

Messages for, 813–817
remote, 806–814
turning on, 828–830

Screen Time, 53, 187–194

screenshots, 227
searches

activity and log, 643–644
advanced, 464–468
App Store, 512–515
Look Up, 460
results, 461–462
Siri, 456–457
Spotlight, 456, 457–460

Secure Boot, 136–138
Secure Shell (SSH), 91, 94
secure startup

Allowed Boot Media, 136, 138
firmware, 134–136, 905–907
initialization and, 901–911
Recovery Assistant, 139–140
Secure Boot, 136–138
security policy, 133–134, 902–905
Startup Security Utility, 129–133, 146–147

security
account privacy, 253–261
Activation Lock, 270–271
app, 520–526, 527, 541
firewall and, 821–826
host-sharing services, 794–795
keychains for, 241–250
lost devices, 262–271
managing system, 250–253
password, 237–241
policy configuration, 133–134
screen locks, 276
search, 463–464
system extensions, 272–274
T2 chip, 129, 902–905

Security & Privacy, 251–253, 637
Select Your Country or Region, 45
Server Message Block 3 (SMB 3), 768
settings

app installation, 525
managing system, 55–70
new setup, 51–52
System Preferences, 73–81
updates and, 21–22
upgrades and, 32
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setup, new, 43–55
Setup Assistant

configuration with, 70–73
new Monterey installation, 43–44
Screen Time, 188
user accounts and, 184

Share Disk, 129, 352–354
Share Menu, 622
Shared folder, 213, 392
sharing

AirDrop, 817–821
changing options, 587
files via iCloud, 585–588
network file-system, 768–778, 785–792
network host-sharing, 793–805
permissions for, 389–393
printers, 878–879
services, 796–798, 826–828
sharing-only accounts, 180
stop, 588

shells, 92
shortcuts

file-system, 415–420
Quick Actions, 623–626
Shortcuts, 8
startup, 907, 922–930

shutdown, 921, 935
Sidecar Diagnostics, 736
single-user mode, 929–930
SIP (System Integrity Protection), 437–439
Siri

configuring, 53
preferences, 468–471
privacy and, 253
search with, 456–457

sleep mode, 794, 913–919
SMB (Server Messenger Block), 756, 773–774
snapshots, 325, 481
software

network services, 753–754
notarization, 521, 543
packages, 526–529
remote control, 806

removing installed, 529–530
updates, 34–36, 155–164, 166–170

Software Update, 160–161, 163, 166–167
special characters, 101
spin reports, 641
Spoken Content, 65
Spotlight

advanced search, 464–468
finding tags with, 454
indexing, 462
plug-ins, 463
preferences, 471–473
search with, 456, 457–460, 477–478

SSV (signed system volume), 329
stacks, 452
standard accounts, 177–178, 202–210
standard formats, 3–4
standard permissions, 386
standby mode, 916
startup

macOS Recovery, 122–127, 142
modifications, 922–930
safe mode, 941–942
See also secure startup

startup disk
FileVault to protect, 53–54
macOS Recovery from, 128
restarts with, 148

Startup Security Utility, 129–134, 146–147
static network locations, 722–724
status, system, 779
stealth mode, 838
storage

APFS, 328–338
defined, 326
iCloud, 571–584, 590, 602–608
local, 579–580, 589–592
new item, 393
password, 281–283
upgrades and, 26
user switching and, 200

storage devices, external
backups with, 482–490
bootable installers, 140–141
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defined, 326
diagnostic reports, 640
erasing, 38–39, 361–363
formatted as APFS, 338
iCloud Drive to, 583
inspections, 342–346
macOS Recovery from, 125
permissions for, 397–398
reformatting, 150–152, 361–363

Storage Management, 589–590, 592
Student Materials, downloading, 81–84
su command, 106
subnet masks, 669
sudo command, 91, 107
swapping, 633
Switch Control, 66
switching users, 197–202
symbolic links, 417–418
system domain, 434
system extension approvals, 272–274, 290–296
System folder, 432
System Information

bus status, 844
disk inspection in, 345
monitoring apps with, 629
peripherals and, 859–862
setup with, 88–90
verifying, 17–20

system initialization, 901–911, 930–934
System Preferences

configuring, 73–81
connectivity monitoring, 687–689
Control Center, 62–63
managing, 55–59

System Recovery, 334
system resources

fonts, 439–447
overview of, 431–437
SIP, 437–439

system settings, 55–70
system volumes, 931–932
system.log, 642

T
T2 chip

FileVault, 368
Find My and, 270
Secure Boot, 136–138
security policy, 902–905
Startup Security Utility, 132

Tab key completion, 101–102
tags, 449–454, 474–477
target disk mode, 352–354
TCP (Transmission Control Protocol), 669
TCP/IP networking, 667, 670, 697, 708–710
Terminal

APFS info in, 334–336
CLI access via, 92–96
file erases in, 349
macOS Recovery from, 128
navigation via, 100
network troubleshoots, 736–745, 780–782

terms and conditions, 50
tethered caching, 801
text, images and, 8–9
third-party kernel extensions, 275, 858
third-party system extensions, 290
Thunderbolt, 847–849
Thunderbolt 2, 848
Thunderbolt 4, 694, 846, 847, 848
Thunderbolt Bridge, 694
Time Machine

backups, 21, 480–481
configuring, 481–492, 497–502
erases and, 937
exclusions, 497
local snapshots, 481
overview of, 479–480
preferences, 490–491
restores from, 127, 492–497, 502–506

TLS (Transport Layer Security), 817
Touch Bar, 623
touch command, 105
Touch ID, 55, 237
traceroute command, 743–744
trackpad, 78–79, 850
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transfers, 352–354, 489–490
trash, 590
troubleshooting

apps, 634–650, 655–661
file systems, 342, 350–355
initialization, 930–934
installation issues, 26–28
network issues, 731–750
peripherals, 843–862
printers, 886–888, 899–900
Recovery for, 121
sharing services, 826–828
system resources, 436–437

trust profiles, 67, 69
two-factor authentication, 48, 249–250

U
Unified Extensible Firmware 

Interface (UEFI), 905
uninstalling apps, 295
Universal apps, 611–612
universal control, 7–8
Universally Unique ID (UUID), 186
UNIX-style permissions, 386
unlocking documents, 601–602
unmounting disks, 338–341
unmounting shares, 776–777
unreadable disks, 346–347
unrecoverable data, 241
updates

app, 520
firmware, 907
macOS, 13
software, 155–164, 166–170, 529

upgrades
macOS, 13–14, 15–26
preparing for, 28–33

USB
built in, 694
cellular network adapters, 695
examining devices, 862
internet access via, 694
performance, 844–885
ports, 845–847

USB-A, 846
USB-C, 845–848
user accounts

access restrictions, 187–194
adding users, 184
attributes, 184–186
configuring, 182–186
creating/editing, 50–51, 183, 202–210, 234
deleting, 219–220
diagnostic reports on, 640
FileVault, 372
folders for, 211–219
locked preferences, 57–58
login options, 194–197
passwords for, 238
permission exams by, 400–405
privacy for, 253–261
remote control and, 807–812
restoring deleted, 226–236
system extension approvals, 290
system resources, 434
types of, 173–174
user switching, 197–202

user home folders
copying/migrating content, 220–226
managing, 211–219
restoring deleted, 226–236

User ID, 185
user keychains, 305–309
user sessions, 901, 911–913, 935–936
Users & Groups preferences, 182–183, 812
Users folder, 432

V
verbose mode, 929–930
versions, document, 565–567, 597–600
virtual display, 828, 832–835
virtual local area network (VLAN), 696
Virtual Network Computing (VNC), 806
virtual network service, 696
virtual private network (VPN), 667, 696
volumes

APFS, 328–338
defined, 327–328
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encrypting, 349–350
erasing, 347–349
mount/unmount/eject, 338–341
navigating, 102–103
renaming, 346
roles and groups, 329
selecting backup, 499–501
system, 931–932
viewing info on, 355–360

VPN settings, 702–706

W
WAN (wide area network) traffic, 671, 698
web browsers, 782–784
WebDAV, 769, 775
widgets, 626–628
Wi-Fi

advanced configuration, 725–730
AirDrop shares, 817
authenticating, 677–679

built-in, 695
connecting to, 675–679, 683–687
connectivity issues, 733–736
defined, 667
hidden networks, 683
manual configuration, 708–713
PAN, 695

wildcard characters, 104–105
Windows computers, 137, 454–455
WINS settings, 697, 715–716
wireless devices, 850
Wireless Diagnostics, 733–736
working directory, 95, 110–112
WPA Enterprise Networks, 678, 680–682

Z
Z shell, 92, 94
ZIP archives, 421–422
Zoom, 63–64
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